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Microsoft( Office 2000
Office Server Extensions and Web Components Functionality and Scenarios

Published: March 1999

For the latest information, please see http://www.microsoft.com/office/

Introduction

Based on actual customer experiences, this chapter captures some of the technical aspects of Microsoft( Office 2000 deployment and deployment planning.  This is a work in progress and will be updated as information becomes available.

This chapter will show how Office Web components and Office Server Extensions can provide a solution for publishing and discussing sales information on the company intranet.

In Focus

Enterprise

A phone book company with listings in traditional hard copy, Internet, and CD-ROM.

Network/Applications

Windows NT(-based servers/Microsoft Office 2000

Challenge

This organization focuses on its customer base through a decentralized model tailored to each customer’s specific needs. This decentralized model presents the challenge of creating an easy-to-use and fast reporting tool. This tool has the goal of proving information about sales results throughout the corporation.

Support

Take advantage of Microsoft Excel 2000’s PivotTables( and PivotCharts( dynamic views to produce sales reporting tools that end users can customize. These tools provide end users with the sales summaries of key areas on a daily and weekly basis. End users will have the ability to drill down on the sales results of individual sales persons and groups. This information will be published to the company intranet using Office 2000 Web components. Office Server Extensions will provide the means for communicating ideas among individual groups about these results using Web Discussions.
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Overview

Today, companies use the intranet and Internet to solve business problems such as distributing information and automating basic business processes. With Microsoft Office 2000, companies can now use their Web infrastructure to solve even more complex business problems. Office 2000 helps address the problem of creating an environment that fosters collaboration in order to produce  the best business decision-making possible. Office 2000 makes it easy to provide employees with access to corporate data and to create collaborative team environments that cultivate information sharing through Office 2000 Web publishing and Web components features. These tools make it easier to provide employees with the right information at the right time so that the best decisions can be made.. This chapter will examine how one company set up and deployed Office Server Extensions and Office Web components to build a collaborative environment and use corporate data. 

About the Enterprise

This document is based upon experiences gleaned from the development of a solution for an Office 2000 Rapid Deployment Program (RDP) customer. Customers belonging to the RDP program are early adopters who have been selected to work with Office 2000 prior to its release. This project involves providing an easy way for managers to obtain real-time sales information. The solution created allows users to publish and access information through Office Publishing, Web Components, and Web Discussions

Business Problem

Management within the organization had no means for obtaining daily sales results. Sales results included how many sales were made, the gross and net sales, and any sales connected to a specific promotion. In the current manual process needing to be replaced, sales representatives would place the raw statistics of what promotions were sold on a whiteboard and clerks would then summarize the information and provide it to sales managers by fax or e-mail. The sales support clerks throughout the organization then manually assembled this information with the purpose of analyzing the effectiveness of individual sales representatives and the sales promotions. The current system has the following challenges:

· It was hard to summarize the information because it was reported differently throughout the company.

· Sales information was re-entered at multiple levels, and each step introducing the possibility of errors in data entry and consuming more time.

· By the time information was summarized in a useful manner it was potentially out of date.

The organization needed an automated process for easily posting sales information and making it available in different ways to users throughout the company. The process had to meet the needs of the following users:

	User
	Needs

	Sales Support Clerk
	Enters the information

	Sales Representative
	Provides sales information

	Sales Coach (Sales Team)
	Needs access to details and summary of sales team

	Regional Sales Manager
	Needs access to details and region summary

	Regional Vice President
	Needs access to details and summaries for all regions

	Vice President of Sales
	Needs access to all data


Project Vision

The primary goal was to streamline the process of reporting daily call-in sales results within the sales organization, making it more timely, less labor intensive, and less prone to error. Providing a tool to easily analyze the information was also a priority.

Once the sales figures were posted, the enterprise wanted to facilitate dialog between the sales people in the field and management to determine the implications of the different figures, replicate what went well, and avoid strategies that were not as effective.

Project Scope

The solution implemented needed to address the following needs:

· Create a method for entering daily sales information into a central database.

· Salesmen will need the ability to add/change/delete sales information within the current week.

· Sales information must be available on a daily basis showing the current day’s call-in results.

· Sales information must be provided for each sales representative, organized by coach.

· Sales information must be organized in the form of daily sales results as well as a weekly summary.

· Provide a means for coaches to add/change/delete/move sales personnel.

· Provide managers with the tools to access and analyze sales numbers.

· Provide a method for managers to discuss sales results.

Project Goals

The project’s goals focused on six major needs within the organization.

· Reduce effort involved in publishing sales information.

· Reduce time involved in publishing sales information.

· Share all the information throughout the organization.

· Provide tools to analyze sales information.

· Provide a forum to collaborate on sales information.

Use existing Office 2000 products to decrease the need for installing another application to each desktop.

Assessing the User Environment

Two different user environments had to be considered in building this solution: Sales and Management. Sales users are the Sales Support clerks and Sales representatives in the organization. Management users consist of those needing access to the detailed and summarized information at different levels. Each group has certain requirements and constraints that will need to be explored and addressed.

Sales Requirements

· Users need the ability to enter sales information for a day.

· Users need the ability to change sales information for a day within the same week.

Sales Constraints

· Users in these roles currently have laptops and computers using earlier versions of the Windows( operating system, with less-capable hardware.

· Not all desktops are 32-bit.

· Users are limited to Microsoft Internet Explorer 3.x (recommended) or Netscape 4 (supported).

Management Requirements

· Users need analysis tools that summarize sales information

· Users need analysis tools that drill down into summaries to get details of different groups.

· Users need a forum to discuss the sales summary and detailed information with other managers.

Management Constraints

· Not all managers have 16-bit platforms.

· Some users are limited to Internet Explorer 3.x or Netscape 4.

Planning and Design

After gathering requirements for the project, it became clear that the end users  in sales did not have a clear idea of what was needed or what was workable for a variety of reasons. First, the sales users were challenged by the technology and did not have an understanding of basic computer operation. Second, there was a perception within the sales teams that the manual system they were using worked “fine” and “does not need to be changed.” Based on this, a prototype pilot was built to give the users an idea of what was possible. The following section outlines the piloted solution. 

Planning for Web Components

To provide the ability to analyze sales information with tools the Managers already knew, and in an environment that was accessible, pivot tables – an Office 2000 Web Component – were created and published to the Web, where they would be accessible via a browser. Office 2000 ships with a series of Web components which mimic some Office features inside of a Web page. These Web components are ActiveX( controls designed specifically for the Web browser. The Web components for Microsoft Excel 2000 display interactive PivotTable views, PivotChart views, and spreadsheets on a Web page. These Web components can be displayed interactively in Internet Explorer 4.01 or later; earlier browsers show a static view.

For examples of Visual Basic( for Applications syntax of Web component objects, see the Appendix.

PivotTable

The first phase of the project was to create an analysis tool that provided an interactive view of sales information in which sales managers could use tools they were used to, such as Excel, to see summary information and easily drill down to the details of each sales representative’s activity. This solution involved building a series of Excel 2000 PivotTable views to access data residing in SQL Server( 7.0. The details for building these tables and the underlying SQL Server 7.0 tables are outlined in the chapter Using Office 2000 as the Front End for SQL 7.0 with OLAP Services in this deployment guide. 

Tip To get consensus on the information that needed to be in the pivot tables, the team met with the users and agreed on the content of the PivotTable views.

Static vs. Active Content

Excel PivotTable views can be static or interactive. Static means that end users see information that is fixed; in other words, they are not provided with tools to reorganize or drill down into data. Interactive means that end users can work with the data; they can reorganize it or drill down into information. Several decisions are connected to the choice of making an Excel 2000 PivotTable static or interactive. An obvious choice is to always provide interactivity to the user. This is an exciting way to provide users with a rich experience in exploring sales information. Unfortunately, this sales organization has some constraints that prevented this choice for some of the sales representatives in the field. These users have older versions of browsers that are not capable of showing interactive content. Additionally, some of these users access the intranet through Remote Access Service (RAS) access only. For this reason, the project needed a static solution as well as an interactive one.

Planning for Office Server Extensions

To achieve the secondary goal of creating a dialog between managers and field sales in order to assess sales programs, Office Server extensions were used to allow for easy web publishing and Web Discussions.

Web publishing allows sales managers and clerks to save to a web server as easily as they save to a file server, so users publishing the pivot tables to a web server running Office Server Extensions did not need to know much more than they already knew when saving information to their local hard drive. This simplifies implementing a web-based solution.

Once information is published, Web Discussions provide a means to discuss the sales results in context of a web page (such as the Pivot Table web component) or even in context of an Excel spreadsheet, PowerPoint( presentation or Word document. Because Office Server Extensions store Web Discussions in a database separate from the content being discussed, the content is never altered so  sales managers need not worry about discussions changing the original sales data.

In addition Office Server Extensions allow users to subscribe to an Office document, spreadsheet, or presentation, so they can be notified when a discussion is added or a file is altered. 

Office Server Extensions is very simple to install—a setup wizard will take you through all of the steps. Office Server Extensions installs MSDE, a fully SQL Server-compliant database, in order to store discussions, but you can also choose to store discussions in a full SQL Server 7.0 database. For this solution, the enterprise chose the second option because they were already maintaining a SQL Server 7.0 database. In order to make Web Subscriptions function properly, you will need the name of the Simple Mail Transfer Protocol (SMTP) mail server and user name. Office Server Extensions uses this mail account to send notifications to the subscriber.

Solution Overview

The analysis tools—the PivotTable views—needed to be accessible to everyone. To accomplish this, PivotTable views were easily converted from Office binary format to HTML using the Excel 2000’s Save As Web Page feature. The resulting Web pages were amazingly similar to the Office binary PivotTable, but needed to be updated to the organization’s standards, which included adding appropriate titles and company logos. 

Microsoft Word 2000 was used to update the HTML page to new organizational standards. After the PivotTable and PivotChart views were generated, team members opened the resulting documents inside of Word 2000 and changed the data to reflect company standards such as company logos, font choices, and colors. The capabilities of Word 2000 made this process easy and required little knowledge on the part of these users. Office 2000 translates text, graphics, and information into Web pages that are as attractive in the browser as they are inside of Word.

Web pages were generated to provide users with the ability to enter new sales information. This was done with the Microsoft FrontPage( 2000 Website creation and management tool.

Office Server Extensions were configured to allow sales clerks and/or managers to easily publish PivotTable views to a web server and to enable discussion about the information contained in the PivotTable views.

Implementation

To implement this solution it was mandated that none of the individuals inside the client organization’s sales groups needed to understand Web page design. With Office 2000's Web features this was possible, because saving to the Web is as easy as saving to a file server. Users only needed to know how to save the new sales reports to the Web.

Using Web Components

End-User Guidelines for Publishing Microsoft Excel 2000 PivotTable Views

First, PivotTable views were created and published to a web site. In order to publish  Pivot tables to a Web site, Sales clerks or managers had to complete the following steps.

1. Ensure that a Web folder has been set up on the user’s desktop by the administrator.
To add a Web folder, double-click the My Computer icon on the desktop to open the My Computer window. Next, double-click the Web Folders icon to access the Web Folders window. Finally, double-click the Add Web Folder icon and type the path of the Web folder you want to add.

2. Choose Save As Web Page on the File menu.

3. Change to the Web folder set up in step 1.

4. Decide whether to make the PivotTable content interactive.

5. Note At this time, an entire workbook cannot be made interactive.

6. Choose Publish on the File menu, ensuring that the proper path appears at the bottom of the Publish As Web Page dialog box and that the title is correct.

Figure 1 shows what the Publish As Web Page dialog box should look like.
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Figure 1. Publish As Web Page Dialog Box

Excel 2000 provides the means to publish PivotTables either in static or interactive format. The Save As Web Page command opens a dialog box that includes a check box. This check box, labeled Add interactivity, determines whether other end users will be able to work with the PivotTable on the Web in the same way as in Excel 2000. Figure 2 shows what this dialog box should look like.


[image: image2.wmf]
Figure 2. Excel 2000 Save As Web Page Dialog Box

End-User Guidelines for Setting Up PivotTables in FrontPage

The goal for this solution went beyond publishing a generic PivotTable to a web site. The goal was to have it adhere to organizational standards with the correct logo, format, and so on. Using PivotTable views in conjunction with FrontPage 2000 helped accomplish this goal.

Excel 2000 PivotTable views can be set up directly inside of FrontPage. Users add spreadsheets to a Web page by choosing Office PivotTable on the Components submenu on the Insert menu. Following these directions should result in the display of a blank Excel 2000 PivotTable.

Note If Office PivotTable does not appear on the Components submenu, check to ensure that a Web page is showing and that the Normal tab is selected in Page view.

Adding Information to a PivotTable

The Office PivotTable control provides many of the features available to Excel 2000 users. Users can add data to the spreadsheet by selecting a specific cell and typing in the data. Advanced property settings are available by right-clicking the spreadsheet and choosing Property Toolbox on the Shortcut menu. A series of menus appears. The purpose of each menu is listed below.

	Menu
	Capabilities

	General
	Selection

	Show/Hide
	Toolbar

Field list

Expand indicators

	Data Source
	Data control


Connecting the PivotTable to Data

Choosing Data Source on the PivotTable Property Toolbox provides two means for connecting a PivotTable to data:

· The Connection option opens the Connection Editor, with the familiar interface for adding a connection to a data source. Users provides the name of the database server, username, password, and database name to establish a connection.

· Users simply select the data control from the list to connect a PivotTable to a data control. The following section explains how to add a data control to a Web page.

Adding the Office Data Control

A data control must be added to the Web page to make this PivotTable functional. This control needs to be added manually through choosing ActiveX Control on the Advanced submenu on the Insert menu. A list of the ActiveX controls installed on the current machine is displayed. Select the data control labeled Microsoft Office Data Source Control 9.

Caution Before selecting the Office data control, be sure that no other control is selected on the Normal tab in Page view; if another control is selected, the data source control will replace it.

Setting Up Fields of a PivotTable

To add fields to the PivotTable, the user needs to display the Fields list. This can be done by either right-clicking the PivotTable or by clicking the Fields toolbar button. Fields may be added to four different sections: Drop Page Fields Here, Drop Column Fields Here, Drop Row Fields Here, and Drop Data Items Here. Click a field and drag it to the appropriate section to add it. To delete a field, highlight it and press delete. More than one field may be added per section.
What Goes in the Drop Fields?

A first look at all the fields on the PivotTable can be a bit confusing. How do you know what kind of data goes into each field? The control itself offers help in this regard by refusing to permit the user to enter inappropriate information. The Data Items field is best for numbers. This is the field that is most appropriate for information like the actual sales of a division or the projected units of soft-drink cans that a warehouse produces. Row Fields and Column Fields contain the different elements being compared in the table. These fields are good candidates for information like the types of soft drinks produced, Sales Managers, Company Divisions, or Automotive types. Page Fields are the filters for the chart. This is where to place information that will allow the user to drill down into the data. Good candidates for this field include Year, Month, Week, Sales Period, or Sales Region.

Note: Spreadsheet and PivotChart Web Components inside of FrontPage 2000 can also be used. See the Appendix for more information.

Using Office Server Extensions

The next section will discuss how Microsoft Office 2000 can be used to build a collaborative environment around Web Pages, documents, spreadsheets, and presentations.  Since PivotTable views were part of a Web Page for this project a collaborative environment was built around Web Pages to allow Sales Managers and Field Sales to discuss sales results..

Installing Office 2000 Server Extensions

Office 2000 Server Extensions resides on a Windows NT-based server or workstation and must be installed separately from regular Microsoft Office 2000 installations. Office Professional and Office Premium contain Office Server Extensions. Choose setupse.exe to start the installation process. 

Requirements

	Category
	Description

	Operating system
	Windows NT Server 4.x with SP4, Windows NT Workstation with SP 4 or

Windows 2000 Server

	File format
	Windows NT File System (NTFS) required to secure Web server

	Web server
	Internet Information Server (IIS) 4.0 for Windows NT Server

Windows NT Personal Web Server for Windows NT Workstation


Setup Process

Setup takes you through a series of screens. You provide licensing information and then click Install Now to begin the installation. When installation is complete, you are prompted to configure the IIS server.

1. Set up the Web server database

The first question to answer refers to the database that will support the Web Discussion and Web Subscriptions. Figure 3 shows what this screen should look like and the kind of information that needs to be entered.
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Figure 3: Web Collaboration Database Configuration Screen 

For more information, see “Installing Office Server Extensions” in Chapter 13 of the Microsoft Office 2000 Resource Kit.

2. Set up user groups

After creating the database, the Installation Wizard prompts you to provide the text to use to prefix local Windows NT user groups that will access the Web server. The default prefix is the name of the Web server. When you click What permissions do users in each group have?, a dialog box is displayed that shows different user groups and the permissions that these groups will have. Figure 4 shows what this dialog box looks like. 
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Figure 4: Create Windows NT Groups Dialog Box

For more information, see “Installing Office Server Extensions” in Chapter 13 of the Microsoft Office 2000 Resource Kit.

3. Set access for the Web

Next, you make access control decisions. Figure 5 shows what the dialog box looks like. At the top, you choose which Windows NT group or user will have administration privileges on the Web site. You also choose who will be able to use Web Discussions and Web Subscriptions. If people in your company are using Web browsers other than Internet Explorer, select the Allow Basic Authentication logins for Collaboration check box. If everyone is using Internet Explorer, it is a good idea to clear this check box. The Office Server Extensions Start Page allows users to browse through the files on this Web site. To remove this access, clear the Enable Directory Browsing on this web site check box. For more information, see “Administering Security with Office Server Extensions” in Chapter 13 of the Microsoft Office 2000 Resource Kit.
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Figure 5: Setting Up Access Control

4. Set up the mail server

The mail server settings in the next dialog box define the mail accounts you want to use for this Web server. Figure 6 shows what this dialog box looks like. Web Subscriptions will not work properly unless you provide the mail account and SMTP server you want to use. It is possible to proceed without providing this information, but remember to come back and enter the mail account and server information later when it is available. For more information, see “Maintaining Office Server Extensions” in Chapter 13 of the Microsoft Office 2000 Resource Kit. 
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Figure 6: Mail Server Settings

Office 2000 Server Extensions Start Page

Microsoft Office 2000 ships with a Start Page located at http://localhost/msoffice/default.asp. This address assumes that the user is on the current machine. If the user is on another machine, substitute the name of the server for localhost. This page provides the user with access to many of the features of Microsoft Office 2000 Server Extensions, including the Search Web Folders and Browse Web Folders commands and managing Web Subscriptions.

Managing Web Subscriptions

If the sales clerks, managers or field sales want to be notified when new information is posted or discussions are added, web subscriptions can be used.  Office 2000 provides administrators with the ability to work with Web Subscriptions on their server. This Web page may be accessed from the Office Server Extensions Start Page. If the administrator is currently on the Office Server Extensions machine, the address of the subscriptions page is http://localhost/msoffice/delsubs.asp. This Web page provides users with the ability to view all subscriptions as well as delete any that are no longer appropriate. Figure 7 shows what this Web page might look like.

[image: image7.png]icrosoft Intemet Explorer [-[Ofx]
Fle Edt Vew Go Favoites Hep

| Gk - & - © [ (1] @seach - GFevotes By |[F @ B B

ks [2] e rossiosimsfice/desbs s =i ”

Manage Web Subscriptions

The list below shaws your curant Wab Subscriptions an this Office-sxtendsd
| server. Click s column heading to sart by that fisld. You can delate any Wab
Subscription by salacting it and hitting Delete.

Current User: NORTHAMERICA\ taylorm

| [ure Subscribed To | Email Address E

Connected to: localhost Delete
| Displaying 1 web Subscription(s)

\ Go Back to the Start Page

BT &%) swbsenber. | | ]
3] || [ Localintanet zone /

] b





Figure 7: Web Subscriptions Manager

End-User Guidelines for Configuring Web Discussion and Web Subscription Settings

With Office 2000 Server Extensions installed, the sales staff is now ready to carry on threaded conversations on specific Web pages. The rest of this section contains information that end users need to know.

Turning On Web Discussions

Turning on Web discussions for specific users is very simple. The users in the sales staff find the icon on their browser and click it. Figure 8 shows what the browser and icon should look like, with the indicated icon button circled with a black circle. If the browser is already connected to a Discussion server, nothing more is necessary for the users to participate in Web discussions.
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Figure 8: Internet Explorer 5 with Discussion Icon circled

Connecting to Web Discussion and Web Subscription Server

If the user’s machine is not configured to work with a specific Web Discussion and Web Subscription server, then the dialog box shown in Figure 9 appears. By default, no server is identified. Using the Office Customization Wizard, you can roll out Office Server Extensions with this information preset on the users machine
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Figure 9: Connection to a Web Discussion and Subscription Server

The user has only to click Add and enter the name of the server to be used for Web Discussions. This is the name of the server that was set up earlier in this chapter. Figure 10 shows what this dialog should look like. Enter the name of the server in the first text box and the friendly name to identify it by.
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Figure10: Enter Discussion Server Dialog Box

Working with Web Discussions

The sales staff may carry on a threaded discussion on a specific Web page by browsing to a specific page and entering a comment. To add a comment, a user clicks one of the buttons that appear at the bottom of the browser screen. Figure 11 shows this series of buttons. A user can enter two types of comments. The first button, labeled Insert Discussion in the document, provides the ability to add a comment to a specific section of a document. Figure 11 shows what a document looks like when the user presses this button. The second button, labeled Insert Discussion about document, gives the user the capability to add a comment directed at the entire document. The example shown in Figure 13 under “Best Practices” is this kind of comment.
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Figure 11: Comment Locations for a Web Discussion

Setting Up Subscriptions

Users can subscribe to a Web page by clicking Subscribe at the bottom of the page. A Discussion Subscription is different than a regular offline Page Subscription. In a Discussion Subscription, the subscribing user receives a message when someone participating in the discussion makes a comment that fits the criteria that was set in the Subscription dialog box. Figure 12 shows what the Subscription dialog box looks like.

[image: image12.png]Subscribe to

& He [FetpTJoffceupdate.microsaft,comfrtides/sr2Fact hir

€ Folder
-
[ | 1l
Notiy me
sihen: anything changes -
Emil options

Addess:  [raplorm@icrosoft.com

(e.q. somesne@nicrosoft.com)

Tine: & -

o cancel





Figure 12: Subscription Dialog Box

An Example of Using Web Discussions and Subscriptions

The sales staff commented on web pages with embedded pivot tables. However, Web pages do not need to be on internal Web sites for users to use Web Discussions and Web Subscriptions. In fact, you can discuss information that resides on a file share, or just as easily comment on the www.microsoft.com Web site as on the internal Human Resources Web page. This can be a very useful feature on external Web pages such as those that give access to software upgrades and service packs. When an upgrade becomes available, an employee goes to the appropriate page and downloads the new file. After the download is complete, he or she leaves a comment on the appropriate page informing others in the company that the file was already downloaded and where other users can obtain it. Figure 13 shows what this might look like.
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Figure 13: Downloaded Service Pack Example

Server Requirements

This project requires the use of two servers running Microsoft Windows NT. For optimal performance, only one Microsoft BackOffice® product should be installed per server. In the current project, SQL Server 7.0 and Microsoft Internet Information Server 4.0 were placed upon separate machines. To ensure the best performance,  each machine was dedicated to one product. Further, by placing each product on separate machines, the plan allowed for more servers to be clustered and added as needs for the application change.

Server #1: Database

This project requires a database to store sales information.

· Windows NT 4.0 Server

· SQL Server 7.0

· OLAP Services

What Is OLAP?

OLAP stands for online analytical processing. This is a middle-tier service that provides data in the form of multi-dimensional cubes of information. These cubes of data are helpful in doing data analysis using the Microsoft Excel 2000 PivotTable and PivotChart features.

Server #2: Web Server

This project requires a Web server to provide a Web presentation to users for two purposes: to allow users to review sales information without needing Office 2000 and to provide a Web data entry system that does not require the application to be installed on individual machines.

· Internet Information Server 4.0

· Office 2000 Server Extensions

Best Practices

Using Office Server Extensions as a File Server

Microsoft Office 2000 Server Extensions provides excellent results for workgroups of 10 to 25 users. Companies requiring solutions for larger groups of users should consider using multiple Office Server Extensions servers to take care of the needs of larger groups of users. There currently is no formula to provide for Web Discussion and Web Subscription servers based on number of users; server load varies according to the amount of server activity.

Deploying Web Components

In order to facilitate the deployment of required Office Web components, there needs to be a common shared location to which all users have access. Users need to access this location through a URL rather than a specific drive mapping. This is the path that needs to be entered into each component’s object reference. (For object reference examples, see the Appendix.)

Evaluating Security Issues

The Web capabilities in Microsoft Office 2000 are provided by the combinations of Windows NT Server, Internet Information Server, FrontPage Server Extension, and Office Server Extensions. To make use of Windows NT Server security you must use the Windows NT file system (NTFS). For more information on securing Web servers, see the Microsoft Office 2000 Resource Kit or the Microsoft Windows NT Server Resource Kit Version 4.0, Supplement One.

More Information

For information on configuring Office Server Extensions, see “Using Office Server Extensions” in the Microsoft Office 2000 Resource Kit.

For information on setting Web server security, see the Microsoft Windows NT Server Resource Kit Version 4.0, Supplement One.

For more information: http://www.microsoft.com/office/ 


Appendix

End-User Guidelines for Setting Up Spreadsheets in Microsoft FrontPage 2000

Excel 2000 spreadsheets can be set up directly inside of FrontPage 2000. Users add spreadsheets to a Web page by choosing Office Spreadsheet on the Components submenu on the Insert menu. Following these directions should result in the display of a blank Excel 2000 spreadsheet.

Note  If Office Spreadsheet does not appear on the Components submenu, check to ensure that a Web page is showing and that the Normal tab is selected in Page view.

Adding Information to a Spreadsheet

The Office Spreadsheet control provides many of the features available to Excel 2000 users. Users can add data to the spreadsheet by selecting a specific cell and typing in the data. Advanced property settings are available by right-clicking the spreadsheet and selecting Property Toolbox on the Shortcut menu. A series of menus appears. The purpose of each menu is listed below.

	Menu
	Capabilities

	General
	Undo

Help

	Format
	Font name, size, color

Cell format

Text alignment

Number format

	Show/Hide
	Toolbar

Gridlines

Title bar

Column headers

Row headers

	Calculations
	Controls how cells are calculated

	Find
	Search feature

	Import Data
	Covers importing data into spreadsheet

	Protection
	Cell-protection features

	Title Bar
	Formatting choices for the title bar

	Advanced
	Advanced features (provides the ability to change such settings as maximum height and width, determining if end user will have access to the Property Toolbox, and deciding if items should appear expanded by default)


End-User Guidelines for Setting Up PivotChart Views in FrontPage 2000

Microsoft Excel 2000 PivotChart views can be set up directly inside of FrontPage. Users add spreadsheets to a Web page by choosing Office PivotChart on the Components submenu on the Insert menu. Following these directions should result in the display of a blank Excel 2000 PivotChart.

Note If Office PivotChart does not appear on the Components submenu, check to ensure that a Web page is showing and that the Normal tab is selected in Page view.

Adding Information to a PivotChart

The Office PivotChart control provides many of the features available to Microsoft Excel 2000 users. A user can add data to the spreadsheet by selecting a specific cell and typing in the data. Advanced property settings are available by right-clicking the spreadsheet and choosing Property Toolbox on the Shortcut menu. A series of menus appears. The purpose of each menu is listed below.

	Menu
	Capabilities

	General
	Undo

Chart type

Help

	Plot Area
	Rotate or flip

	Format
	Border weight

Border color

Interior color


What If Adding a PivotChart Causes an Error?

Failure to provide a data source will result in an error message: “There are no data sources on this page from which to create a chart. When you click OK this Wizard will close. To create a chart you must first place one or more data controls on this Web page.” Please consult the following two sections for instructions on doing this.

Connecting to Data

A PivotChart must connect to a PivotTable in order to function properly. If a PivotTable already exists on the current Web page, the Microsoft Office Chart Wizard appears. The first choice is to determine the chart type that best fits the data. Second, pick the data source and PivotTable to use as source for the PivotChart. It is not necessary to change this information unless there are multiple PivotChart views on the same Web page.

Adding the Office Data Control

A data control must be added to the Web page to make this PivotTable functional. This control needs to be added manually through choosing ActiveX Control on the Advanced submenu on the Insert menu. A list of the ActiveX controls installed on the current machine is displayed. Select the data control labeled Microsoft Office Data Source Control 9.

Caution Before selecting the Office data control, be sure that no other control is selected on the Normal tab in Page view; if another control is selected, the data source control will replace it.

Setting Up Fields of a PivotChart

To add fields to the PivotTable, display the Fields list by either right-clicking the PivotTable or by clicking the Field List toolbar button. Fields may be added to four different sections: Drop Data Items Here, Drop More Category Fields Here, Drop More Series Fields Here, and Drop Page Fields Here. Simply click a field and drag it to the appropriate section to add it. To delete a field, highlight it and press delete. More than one field may be added per section.

What Goes in the Drop Fields?

A first look at all the fields on the PivotChart can be a bit confusing. How do you know what kind of data goes into each field? The control itself offers help in this regard by refusing to permit the user to enter inappropriate information. The Data Items field is best for numbers. This is the field that is most appropriate for information like the actual sales of a division or the projected units of soft-drink cans that a warehouse produces. Category Fields contains the different elements being compared in the chart. This field is a good candidate for information like the types of soft drinks produced, Sales Managers, Company Divisions, or Automotive types. In order to differentiate between them, these same elements should be added to the Series Fields. By doing this, each element has a different color and is easily differentiated. Page Fields are the filters for the chart. This is where to place information that will allow the user to drill down into the data. Good candidates for this field include Year, Month, Week, Sales Period, or Sales Region.

What If the PivotChart Changed?

Changes made to either the PivotChart or underlying PivotTable have a direct effect on the appearance of the chart or table. Something as simple as adding a new field to the data items will have the result of adding that same field to the PivotChart. For this reason, it is best to have a separate source PivotTable for the chart to prevent any unexpected changes to the PivotChart.

Web Spreadsheet Object Model Example

An interactive display of the contents of a Web page utilizes one Web component. The example below shows the class IDs for this control. The final parameter of this control is HTMLData. Notice that the value is not set to anything in this example. This property contains the data to be placed within the spreadsheet, and to save space the data was not included. The path for the cab files defaults to the installation path for Office. For choices other than the default, this path will need to be changed on all generated Web pages.

<object id="Premise Sales_16734_WebCalc"
 codebase="file:C:\Office 2000\cd1\msowc.cab#version=9,0,0,2209"
 classid="CLSID:0002E510-0000-0000-C000-000000000046" width="384" height="288">
 <param name=DisplayTitleBar value=false>
 <param name=DataType value=HTMLData>
 <param name=HTMLData
 value="

PivotTable Web Components Object Model Examples

An interactive PivotTable on a Web page utilizes two Web components: DataSourceControl and PivotTable. The examples below show the class IDs for each of these controls as well as some sample settings. The path for the cab files defaults to the installation path for Office. For choices other than the default, this path will need to be changed on all generated Web pages.

DataSource Object Model Example

The DataSourceControl icon resembles the Microsoft Access key. It is displayed on the Normal tab in Page view in FrontPage. Switching to the HTML tab in Page view will display the object tag and a series of settings in XML below it. Within the XML is the information for connecting to the database table. All this information appears under the single parameter name XMLData. The connection string for the data control can easily be found by doing a search for “ConnectionString”.

<object id="Premise Sales_12924_DSC"
 codebase="file:C:\Office 2000\cd1\msowc.cab#version=9,0,0,2209"
 classid="CLSID:0002E530-0000-0000-C000-000000000046" width="16" height="15">

PivotTable Object Model Example

The PivotTable control appears as a PivotTable on the Normal tab in Page view in FrontPage. Switching to the HTML tab in Page view will display the object tag and a series of settings in XML below it. Within the XML is the information for connecting to the data control. All this information appears under the single parameter name XMLData. The different pivot fields and settings can easily be found by searching for “PivotField” or the specific name of a pivot field.

<object id="Premise Sales_12924_PivotList"
 codebase="file:C:\Office 2000\cd1\msowc.cab#version=9,0,0,2209"
 classid="CLSID:0002E520-0000-0000-C000-000000000046" width="527" height="261">

PivotChart Web Component Object Model Example

An interactive PivotChart on a Web page utilizes two Web components: DataSourceControl and PivotChart. The example below shows the class IDs for the PivotChart control as well as some sample settings. The path for the cab files defaults to the installation path for Office. For choices other than the default, this path must be changed on all generated Web pages.

<object id="Premise Sales_3854_WebChart"
 codebase="file:C:\Office 2000\cd1\msowc.cab#version=9,0,0,2209"
 classid="CLSID:0002E500-0000-0000-C000-000000000046" width="80%" height="80%">
 <param name="XMLData" value="&lt;?xml:namespace ns=&quot;urn:schemas-microsoft-com:office:excel&quot; prefix=&quot;x&quot;?&gt;

The information contained in this document represents the current view of Microsoft Corporation on the issues discussed as of the date of publication. Because Microsoft must respond to changing market conditions, it should not be interpreted to be a commitment on the part of Microsoft, and Microsoft cannot guarantee the accuracy of any information presented after the date of publication.

This document is for informational purposes only. MICROSOFT MAKES NO WARRANTIES, EXPRESS OR IMPLIED, IN THIS DOCUMENT.
( 1999 Microsoft Corporation. All rights reserved.

Microsoft, Active X, BackOffice, FrontPage, PivotChart, PivotTable, PowerPoint, Visual Basic, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft in the United States and/or other countries.

Other company or product names herein may be the trademarks of their respective owners.
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